//// Trustmark

Pro-Chex
Quick Reference Guide

Version 1.0

March 1, 2024

Proprietary & Confidentiality Statement: This document and the information disclosed within, including the document structure and contents,
are confidential and the proprietary property of Trustmark and are protected by copyright, trade secret or other proprietary rights pursuant to
federal and state law. The receipt or possession of this document by you does not convey any rights to you over the contents, and you are strictly
prohibited from reproducing, disclosing its contents, or manufacturing, using, or selling anything described herein without the prior written
permission of Trustmark.



Pro-Chex Quick Reference Guide ,///% Trustmark
Contents
L OVEIVIBW...c..eiiieeee ettt et e s b e e s b et st e s b e e e s bt e s b e e e s me e e sabe e e smb e e sare e s amneesaneeennnes 3
2. MaNAgING ISSUE IEBMIS..........eeiiiiiiii it e e e e e e s s e st e e e e e e e s sa s bebaeeeeeeeessassnnnneeesessnsnnenns 3
2.1 ManUAl ENErY OVEIVIEW ......coocviiiiiciiiieecteee ettt ettt e e et e e e et e e e e e ata e e e sntaeeesasaeeeensaeeesansaeeesansseeeann 3
R X V= =T T | =PRSS 7
O o e [ T EY U= o =TSP 14
A1 MUILIPIE PAYEES ...ttt ettt e e e e e e e e et e e e e e bt e e e e e bae e e e nbaaeeesaseeeeeenbeeeesanseeeeennsenas 19
4.2 Direct Send Issue File Recommendations..............cocooiiiiiiiiiiiiniieeeeee e 20
4.3 ISSUANCE DUAI APPIrOVAL........coiiieiiiiiiiiii et ee e e e sbee e e st e e e e sabeee s esbeeeeenareeas 21
4.4 Disabled StOP PayMENTS..........cccciiiiiiiiiie ettt e e e s e bee e e e ae e e et e e e e e eabeee e enreeeeenareeas 21
B ISSUE WArEROUSE ..ottt ettt e et e sttt esab e e st e e s bteesabeeebbeesabeesnaeesareens 22
5.1 MOdifyiNg ISSUE EEIMS ........oeiiiiiiiieeeee et e e e et e e e e ab e e e s e abe e e e eabeeeeenseeeeennsenas 25
Lo 10Ty o T e o) (T« USSRt 27
7. Other Options Prior to Item Presentment............cooooiiiiiiiiiii e 28
7.1 MOdifyiNg ISSUE IEEIMS ...t e e e bee e e st e e e e s st e e e e s abeeesenseeesennsenas 28
7.2 MANUAI RE-ENIY.......coiiiiiiieeeeee et e e e e te e e et e e e e e abe e e s atbaeeeeasbaeeeaaseeeeenbeeesennseeeeennsenas 29
T3 Fl@ REIOAAS.........coeiiiii ettt st et e b e b e s bt e s atesat e et e e sbeesheesanenas 29
8. Managing Check PresentMeNnt .................ooooiiiiiiiiiiii ettt e e et e e e et e e e e ata e e e e nsreeesenneaeaean 31
8.1 TranSACHION HiSTOIY.......cooiiiiiiiiiiiiiii it e e s s s st e e e e e e s s ssaabbaaeeeesssasssreaeeeeas 31
8.1.1 View Transaction HiStOry ..., 32
8.2 Change TranSaCtioN STAtUS .............ccoiiiiiiiiiiiee ettt ee e e e e e tee e e e sabae e e esateeeeeeabaeeseanseeeeennsenas 37
8.3 Change StatUS: PaY ........ooociiiiiiiiie ettt e et e e e e et e e e e e be e e e e abaeeeeeateeeeeeabeeeeeanseeeeennrenas 37
8.4 Change Status: RETUIN..........cooiiiiiii e e e ee e s et e e e e e eabeae e esabeeeeenaseeas 37
8.5 DUPIICAte PreSENtMENT............ovviiiiiiiiiieeee ettt e e e e e e e eabbr e e e e e e e sestabaaaaeeeessenasrraeeeeas 38
0] aleT s T 1 I Vot o] LU PRPRRU 40
8.6.1 Confirm Paying EXCEPLIONS............c.ooiiiiiiiiei ettt e e e tee e e et e e e e bae e e e nreeas 40
8.6.2 PAY QN ISSUE ........oooiiieieiiiiiiee et e e e et e e e e e s e s bt e e e e e e e esassteeeeeaesessansstraneaaaeeaannnrnes 41
8.6.3 MasS Pay aNd ISSUE............coooviiiiiiiiiie ettt e e rtee e e e etre e e et e e e e eeabae e s esabaeeeenaraeas 42
8.6.4 Pay & AJUST ..ot st et ae e es 43
8.7 REVIEW PAYE..........oviiiiiiiiiiiiiieeee ettt e e e e e ee e e e e e e e s sttt a e e e e e e s es bbbt aaeeeeessassssbtaaaeeesssnnssrenaaaes 44



Pro-Chex Quick Reference Guide

//// Trustmark

N

1. Overview

This Quick Reference Guide (QRG) is meant to provide information on the most used positive pay
functionality within Pro-Chex. For comprehensive information on all options and functionality within
Pro-Chex, refer to the full Pro-Chex Client User Guide and use the linked table of contents to jump
directly to the desired section.

2. Managing Issue ltems

2.1 Manual Entry Overview
You can manually enter a list of checks that have been issued.

The table below describes fields that may display in the Manual Entry screen, criteria for the field to
display, and how the information entered is used to identify exceptions when matching issue items to
checks presented for payment.

Field Criteria Use
Serial # Check/Serial number of the issue. Identifies if the check was
e This field is always required. issued or presented more than
once.
Amount Dollar value of the issue. Identifies if the amount of a

e This field is always required.

check has been altered.

Payee Name

Person(s) or entities to whom the check was

intended to pay.

e This field supports entry of up to four
multiple payee names. Click Enter to input
another name on the next line.

e This feature is optional, and the field only
displays for accounts configured for payee
positive pay.

Note: When enabled, if a payee is required in
an issuance file, values consisting of only
white space (ex., all spaces) are considered
the same as an empty value and are not
accepted.

e This field supports both alphabetic and
numeric characters.

e Multi-Line Payee Names cannot be utilized
on accounts with a Custom Payee Box
enabled.

Identifies if the name in the Pay
to the order of line has been
altered.

Status

This value advises Trustmark if a check has been

issued and distributed, issued and later voided,

not distributed or issued, and if it was

distributed and a stop payment order was

requested later.

e The issued and void status values are always
available for selection.

Determines if a check should be
analyzed for matching (issued)
or if a check was presented for
payment previously voided or
stopped.
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e The stopped status only displays if
Trustmark enabled this option for you to
designate.

e Each check should be accounted for, even

those voided or with a stop payment issued.

Issuance Date

Date the check was issued and valid for

payment.

e This field is always required.

e The issuance date always defaults to the
current date, but the user can assign a back
or future date.

Determine if a check is
presented earlier than intended
or later than allowed.

Additional Issue
Fields

Only available if the Issue Templates user

privilege is turned on for a user.

e Additional issue fields are typically used if
you require Check Positive Pay (PRO-CHEX)
to retain information related to the issued
item for reconciliation purposes.

Used for account reconciliation
purposes. Example: To match
an invoice # associated with a
check.

1. From the Check Positive Pay (PRO-CHEX) module, click Perform > Manual Issue Entry.

PRO-CHEX £ Manage

Ll
i
Ll

- # Perform =

Issue File Load

Manual Issue Entry |

(
Welcome Transaction Approval

Active Reconciliation

Please use the above men

Statement Balance Entry

Paid No Issue Match

The Manual Issue Entry screen displays.

Account’

Save

Manual Issue Entry

Auto populate next check number:

Row Serial Number Amount Payee Mame’ Status

ISSUED

© Click any row to select that row for editing

Issuance Date

03/03/2021
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The table below describes the fields in the Manual Issue File screen.

Field Description

Account Used to select the appropriate Account Number from the drop-down.
Auto populate | When checked, the next check number auto-populates in the following row.
next check e This feature is designed to eliminate serial number entry when checks are issued in
number sequential order.
o When unchecked, the next check number remains blank until it is fill Issued in by the
user.
Row Each issue item is numbered in the order entered.
e Once the cursor is placed in the current row, an additional row displays for the next
entry.
Serial Number | Used to enter the item serial number for this manual issuance file.
Amount Used to enter the dollar amount for this manual issuance file.
e You can also use the up and down arrows to select a dollar amount.
Payee Name Used to enter the payee’s name for this manual issuance file.

e The Payee Name field supports the entry of a single or multiple payees.

e This field supports both alphabetic and numeric characters.

e See Step #3 below for in-depth information about the Payee Name field and Multiple
Payee Names.

Status Issued — The check was issued.

Voided — The check was voided by the maker.

Stopped — A stop payment was placed on the check.

Issuance Date | Click Issuance Date and select the date this item was issued.

e On accounts configured for active account reconciliation, the Manual Issue Entry
screen will not permit selecting a date prior to the start date of the current
reconciliation period.

2. Click Payee Name to enter up to four payees. If entering multiple payees, press Enter and input the
payee name for each additional payee.

Row Serial Number Amount Payee Name’ Status Issuance Date

10100 300.00 ISSUED h [ 03/03/2021

You can enlarge the view size on the Payee Name field by dragging the bottom right corner of the field
box. This feature is not available in all browsers.

Row Serial Number Amount Payee Name’ Status Issuance Date

10100 300.00 ) ISSUED bl B 03032021

This functionality is not available if Trustmark enabled Custom Payee Boxing for an account. If multiple-
payees are listed on a single line of the check, putting them on separate lines is not applicable.
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e The Payee Name field currently supports 500 alphanumeric characters in total. This count includes
the carriage returns separating multiple payees. The 500-character limit is for the entire field and not
per payee.

e 500 characters are allowed in this field; however, names may be truncated if using a fixed width
template, and the number of characters allowed in that column is less than 500.

Row Serial Number Amount Payee Name’ Status Issuance Date

1 - aa

10100 300.00 Helen Jones & Lisa Mil erI ISSUED e | 03/03/2021

3. If Payee Positive Pay is enabled, the Payee Name field will not accept blank entries for items with
an Issued status. An error message returns if there is an attempt to save an entry without a payee
name.

Payee Name is required unless status is VOIDED.

o Click in any field(s) that need to be edited and make changes.
e After all manual issuance files have been entered, click Save.

The Manual Issuance File Status Detail screen displays.

< Back to Status MANUAL_1617197309551
File Status
Queued Processed Approved Completed Deleted
Fi ng i mple list bel 5
® View items: 2 Items totaling $80,001.00 Load Date: 03/31/2021 09:28:29 EDT
Rows1-2of 2.
Account Number Serial Number Amount Payee Name Status Issuance Date
o111 40000 $40,000.00 Formula 1 AVAILABLE_FOR_MATCHING 03/31/2021
o111 40001 $40,001.00 Lewis Hamilton AVAILABLE_FOR_MATCHING 03/31/2021
Delete
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The table below describes the fields on the Manual Issuance File Status screen.

Field Description

Load Date Date and time the file was loaded.

Account Number | The account number on each issue item.

Serial Number The serial number of the issue item.

Amount The dollar amount of the issue item.

Payee Name Name of the payee(s) from the issue item.

Status Available_For_Matching — Issued item is available for exception matching

against an incoming check.

Duplicate Issuance — Issued item is a duplicate and already issued.

Used in Matching — Issued item was used in exception matching against an
incoming check.

Issuance Date The dollar amount of the issue item.

Click Back to Status to view the Issuance File Status page.

3. Issue Templates

Issue templates make it easy to load issue items into Check Positive Pay (Pro-Chex) using files generated
out of most accounting systems. Pro-Chex provides a variety of flexible options for providing a list of
issued or voided checks.

e Issue templates allow users to select from a list of file formats supported and identify where
required data elements are located within the file.

e Once atemplate is set up, it can be selected when loading a file to tell Check Positive Pay (Pro-
Chex) how to use the data contained in the file.

o Multiple file templates can be set up, displayed, and used. Trustmark can create templates for
you to use or allow you to create your own templates.
Note: The Issue Templates user privilege must be enabled.

1. From within the Check Positive Pay (Pro-Chex) module, click Manage > Issue Templates.

(1}
]
t
T
1

PRO-CHEX £3 Manage ~ # Perform JiReports «

[ Issue Templates ] Af—

Additional Issue Fields
vvelrcome

Please use the above menu to select an action
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The system displays a list of existing templates available for viewing or editing, and a Create New

Template button.

Templates created by Trustmark cannot be modified.
Templates you create can be modified by both you and Trustmark.

Click the eye icon in the Edit/View column to view a template created by Trustmark.

2. Click the pencil icon next to a template to view or edit the template. The template displays the date
the template was last updated.
Edit Template: 2105 Template C Last Updated: 12/13/2021
Template Name File Type’ Template Status
2105 Template C Excel Workbook v Active

3. To delete an existing template, click the checkbox next to the template to be deleted and click Delete
Selected. Templates with the Delete option were built by you and can be deleted/edited. Templates
without the Delete option were built by Trustmark and cannot be deleted/edited.

4. Click Create New Template to create a new template.

e The upper portion of the template screen will not change regardless of the file type selected.
e The Template Name, File Type, and Template Status values are required. The Number of Header

Rows and Number of Footer Rows fields are optional.

Create New Template

Template Name File Type’ Template Status
- select file type v Active

Number of Header Rows’ Number of Footer rows’ Template Level’
0 0 Client

Multi-Line Payee Name Separator:’?

Do not use a character as a separator if

The table below describes the fields for the Create New Template screen.
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Template Name | Name of the template being created.

File Type Select the appropriate file type. Check Positive Pay (Pro-Chex) accepts issuance
file uploads with the following formats:
Comma Separated (.csv) W e

322172441,1111111111,509.00, 138, 20210201, tr9993,45879 ,Mis¢c, , , , , DEPOSIT
322172441,1111111111, 650,08, 139, 2021828
322172441,2222222222,65.00,148,20210201 , tr
322172441,2222222222,150.00,141, 20210201, ¢
322172441,2222222222,489.00,142,20210201, t
322172441,2222222222,54.00,143, 20210201 , ¢
322172441,3333333333,480.00,144,20210201,tr9999,457896, , , , , , CHECK

Fixed Width (.txt)

Excel Workbook (.xIsx)

Excel 97-2003 Workbook (.xls) | —= = = e —

Pipe Separated (.csv) 1 125|7000 | ISSUED| 2222222222
2 126|800 | ISSUED| 2222222222

Semi-colon Separated (.csv) 3 127, 7000 ISSUED. 2222222222

128;8000;I55UED; 222222222

Tab Separated (.txt)

F?T—- 000 ISSUED 2222222221
124 6000 ISSUED 2222222222

Template Status | Can be set to Active or Inactive. Active templates are used for loading issue files;
inactive templates cannot be used for issue file loading.

Number of Many accounting systems can export Excel or fixed width files. Sometimes those
Header/Footer files have header (beginning) rows or footer (ending) rows containing data not
Rows required by Check Positive Pay (Pro-Chex).

When setting up a template, the Client can define the number of rows Check
Positive Pay (Pro-Chex) should ignore at the beginning and end of the file. If the
values are entered incorrectly, an issue file may load with errors or no items.
The mapping section below displays based on the file type selected.

Note: Fields/options seen in these images may be available for your organization based on settings
configured by Trustmark.
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Excel and separated files require you to define the column data elements that will be found.

Create New Template

Template Name File Type’ Template Status
- select file type v Active

Number of Header Rows’ Number of Footer rows’ Template Level
0 0 Client

Multi-Line Payee Name Separator:

Do not use a character as a separator if
that character will ever be presentin a
Payee Name. Allowed characters in
brackets[: |.-_/]

This Client has not been setup for client additional issue fields in templates.

Configure in Client level settings and setup client additional issue fields for the Client and try again.
File Mapping
Add  Input Field’ File Column’ Field Format

Serial Number

Amount’ @® Fractional Dollars (12.34)
O Whole numbers of cents (1234)

tatus’ [SSUED - for ISSUED
STOPPED - for STOPPED
VOIDED - for VOIDED
O Account Number’
O Issuance Date’
= Payee Name’
O Routing Number’
= ’- Place the cursor over this label for more information

10
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files require you to define the start and end position in which the data element is located.

haracter

brackets [;

Configure in C

Create New Template

Template Name File Type’ Template Status
Fixed Width v Active v

Number of Header Rows’ Number of Footer rows’ Template Level’
Client v

Multi-Line Payee Name Separator: ’

Do not use a character as a separator if

Payee Name. Allowed characters in

This Client has

Add  Input Field’ Start Position’ End Position’ Field Format

Serial Number

Amount ® Fractional Dollars (12.34)

Status’ ISSUED - for ISSUED
P - for STOPPED
o - for VOIDED

Account Number’

Issuance Date’

Payee Name

Routing Number

will ever be presentin a

not been setup for client additional issue fields in templates.

ient level settings and setup client additional issue fields for the Client and try again.

Whole numbers of cents (1234)

e The File Mapping section on the lower part of the screen displays the required fields.
e The Serial Number and Amount fields are always required. You must specify if the Amount data in
the imported file will or will not contain decimal points.

o

If the Amount value is set to fractional dollars, then 100, 100.0 and 100.00 are all processed
the same.

If the Amount value is set to whole numbers of cents, the system divides by 100 and saves it
as a dollar value. For example, a value of 100 is saved as $1.00 in the system.

11
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You can import additional data by checking the Add box next to the desired data element.

If the status box is not checked (as shown below), Check Positive Pay (Pro-Chex) loads all issue items

with a status of Issued.

If your file represents voided items as a negative number, you can check Treat Negative Amount as
Void and Pro-Chex will status any item in the file with a negative value as Voided.
Issuances with a SO amount are treated as void.

Create New Template

Template Name

Number of Header Rows’

File Type’

- select file type v

Number of Footer rows’

Template Status

Active v

Multi-Line Payee Name Separator:

Do not use a character as a separator if

that character will ever be presentin a
Payee Name. Allowed characters in
brackets [; ]

Add Input Field’ File Column’®

Serial Number

Amount

0 Status’

Template Level’

Client W

Field Format

@® Fractional Dollars (12.34)
) Whole numbers of cents (1234)

Treat Negative Amount As Void’
Issuance with $0 amount will be treated as Void

o If you check the Status box, additional fields display as shown below.
e |f your accounting system exports issue items with an Issued or Voided status, no additional action is
required.
Status’ ISSUED - for ISSUED
STOPPED - for STOPPED
VOIDED - for VOIDED

12
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o [f the Status box is checked for a template, and this information is not provided in the issue file
loaded, the system gives each record an ISSUED status. In addition, the STOPPED status may not
appear in the Template configuration screen if Trustmark has disabled stop payments.

o |f the accounting system used exports issued items with a value of X and voided items with a value of
Y, you can identify the values as shown below so Check Positive Pay (Pro-Chex) can translate the data
appropriately when importing the data.

Status’

- for ISSUED
- for STOPPED

- for VOIDED

The table below describes system behavior if additional data elements are included.

Field Description

Account #

If the Account box is selected, you can import one file that contains issues items for
multiple accounts.

If the Account box is not selected and you load a file through the Client portal, Check
Positive Pay (Pro-Chex) requires you to select the account on which the checks were
issued.

Issuance Date

If the Issuance Date box is not checked, Check Positive Pay (PRO-CHEX) defaults the
issue date to date the file was loaded.

If the issuance date box is checked, the file must contain an issuance date for each
item.

For Excel files, PRO-CHEX translates the data format used in the file.

For separated and fixed width files, you must define the date format being used as
shown in the screenshot below. The formats displayed are examples only. A complete
list of date formats can be found at:
https://docs.oracle.com/javase/8/docs/api/java/time/format/DateTimeFormatter.htm

[#patterns

Issuance Date’

M for month, d for day of month, y for year
Examples:

yyyy-MM-dd for 2019-12-25

MM/dd/yy for 12/25/19

MMM dd, yyyy for Dec 25, 2019

Payee Name

The Payee Name box displays if one or more accounts are configured for payee
positive pay.

If the box is checked, Check Positive Pay (Pro-Chex) requires the payee name for
accounts configured for payee positive pay.

If the payee name is provided for accounts not enrolled in payee positive pay, the
payee name data is ignored when the file is loaded.

For Excel or delimited files, the complete and single payee name is expected in a
single column.

13
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e For fixed width files, the complete and single payee name must be contained in the
file between the starting and ending position.

e This field supports both alphabetic and numeric characters.

e When a payee name is required in an issuance file, values consisting of only white
space (i.e., all spaces) are considered the same as an empty value and are not
accepted.

o If the Multiple Payee Names feature is enabled, the Issuance Payee name may
display more than one payee.

e Multi-Line Payee Names cannot be used on accounts with a Custom Payee Box
enabled.

4. Loading Issue Files

Check Positive Pay (PRO-CHEX) allows you to load issue files into the system for use in matching. PRO-
CHEX accepts these files in a variety of formats, used in conjunction with file templates (covered in the
previous subsection).

e The Load Issuance File user privilege must be enabled.

o Issue file loading strips and ignores dollar signs on dollar amounts and double and single quotations
around data fields.

e For best results, do not load issue files with mixed account numbers unless they have access to all the
listed accounts. Loading issue files with account numbers for which the user has no access will cause
errors.

o There is a 100-character limit on issuance file names.

e Inthe case of an issuance file containing voids or stops being loaded to overwrite previously issued
(outstanding) items, the system updates the status of the issued items, but keeps the original amount
of the issued item, even if the void or stop amounts are listed in the issuance file.

1. From the Client Portal Check Positive Pay module, click Perform > Issue File Load.

PRO-CHEX  # Manage = !'Perforzv i Reports ~

I Issue File Load f—

Manual Issue Entry

We | CO me Transaction Approval

_ Active Reconciliation
Please use the above men

Statement Balance Entry

Paid No Issue Match

14
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2. Click the Template to Use With Issue File drop-down box and select one of the available templates. If

only one template is available, it is selected by default.

//// Trustmark

Issue File Load

Template to Use With Issue File Account?
v - not selected - v

Create New Template

Excel Workbook 2

FFF Escrow - oomd444
FFF Expense - xxxx3333
FFF Payroll - xo002222

FFFriends - xoomt1111

View Selected Template

Select account and template that matches issue file format

3. If the template selected was created without the Account field enabled, a drop-down box displays;
select from the list of accounts. If only one account is available, it is selected by default.

Issue File Load

Template to Use With Issue File
v Create New Template

- select template -
[ - select template -
| 1234
csv
DBFI Fixed Width
Excel 97-2003 Workbook

Excel Workbook
Excel Workbook 2
TestTemplated

tester

4. Click Browse to select the appropriate file.

Issue File Load

Account’

Template to Use With Issue File
Create New Template

The One and Only - 00001111 -

Admin FI Level Template

View Selected Template

Select one issue file that is in the format of the selected template

Browse ...

15
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Once the file is selected, it displays in the upload interface:

Issue File Load

Template to Use With Issue File Account’

Admin FI Level Template v The One and Only - xococ1 111 v Create New Template

View Selected Template

Select one issue file that is in the format of the selected template

(-1

Issue 10182022-001.xlsx Remaove Upload Browse ...

There are three options available:

e Remove - selected to remove the file from the page.
e Browse — used to locate the file you want to load.

e Upload — selected to upload the selected file.

5. The Status Bar displays the status of the file.

< Back to Status WKP1 Issue 1028-001.xIsx

File Status

Queuved Processed Approved / Rejected Completed Deleted

If errors are encountered during the initial processing of the issuance file, the Parse Errors display
displays, allowing you to view the error detail within the file.

e This most commonly displays when the file contains improper formatting. You have the option to:

o Correct those errors.

o Delete individual errors. This feature only displays if there are errors in the file and is only

available until errors are corrected and the file is saved.

o Delete all errors. This feature only displays if there are errors in the file and is only available

until errors are corrected and the file is saved.
o This retains the totals and counts for audit history.
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Discard the File displays when there is an error in the file.
e This option is not available after corrections are made and saved.
e This removes the file and its contents from the system.

< Back to Status ASBC1 Issue 0415-004.xlsx
File Status

Queued Processed Approved / Rejected Completed Deleted
Errors occurred during loading. View list below it errors. If errors remain after 04/21/21, the issuance omatically discarded.

@® Edit 4 Errors

Rows 1-40of 4,
Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete
7 z1111 11568 $30.00 Richard Canova ISSUED 04/15/2021 i
6 21 11567 $260.00 Office Pride ISSUED 04/15/2021 [1]
5 z11 11566 $600.00 Jonathan Copeland ISSUED 0471512021 &
Michael Copeland
4 21111 11565 $65.55 Cisco Webex, LLC ISSUED 04/15/2021 -]

© Click any row to select that row for editing

Discard File sve

In this case, the account numbers in the issuance file were entered incorrectly and must be corrected
before the file can be fully processed and loaded.

6. Click any fields highlighted in red to make updates or changes.

® Edit 4 Errors
Rows 1-4of 4.
Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete
z1111 11568 30 Richard Canova ISSUED 2021-04-15

< - select accoun’ v 11568 s | 30 Richiard Cariova ISSUED v i 04n52021 8
The One and Only - xxxx1111 —

6 PC Test - ¢ 11567 $260.00 Office Pride ISSUED 04/15/2021 8
PC Test - x00
Gilbert's Grapes - xxxx6732

In this example, the user is presented with an account number drop-down to choose the correct account
number for the issuance item.

17
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7. Once all errors are corrected, the red highlights are no longer visible. Click Save and Submit to
reprocess the file. This feature is only available until all errors are corrected, deleted, or discarded.

® Edit 4 Errors
Rows 1-40of4.
Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete
7 The One and Only 11568 $30.00 Richard Canova ISSUED 04/15/2021 [}
-x0x1111
6 2HH +H567 5266:60 OfficePride 55080 O4F15/202% P4
5 The One and Only 11566 $600.00 Jonathan Copeland ISSUED 04/15/2021 5
- 001111 Michael Copeland
4 The One and Only 11565 $65.55 Cisco Webex, LLC ISSUED 04/15/2021 [}
=111
O click any row to select that row for editing 1
Discard File Save and Submit

8. If the file is processed successfully, you can view details on all items in the file.
o |f there are no errors in the file during the initial load, the file automatically displays as approved and
complete.

< Back to Status PGO1 Issue 0303-002.xisx
File Status
Queued Processed Approved Completed Deleted
File processing is complete. View list below to see items.
® View items: 15 Items totali ng $12,246.81 Load Date: 03/03/2021 15:07:38 EST
Rows 1-150f15
Account Number Serial Number Amount Payee Name Status Issuance Date
03783 2665 $65.55 Cisco Webex, LLC NEW_ISSUANCE_ITEM 0370372021
0003783 2666 $60000 jonathan Copeland NEW_ISSUANCE_ITEM 0370372021
Michael Copeland
0003783 2667 $260.00 Office Pride NEW_ISSUANCE_ITEM 3/03/202
03783 266 $75.00 Richard Canova NEW_ISSUANCE_ITEM 3/2021
xxxx3783 2669 $933.00 Watler Lansden Dortch & Davis, LLP NEW,
wox3783 26 $24.00 Advanced Medica NEW_IS!
003783 2671 $6,130.00 Citizens Union Bank NEW 03/037202
003783 2672 §53.36 Covey Seminars
003783 2673 $193.93 Cuyahoga County Clerk NEW_ISSUANCE_ITEM 03037202
003783 2674 $2.800.0 Michael Farre NEW_ISSUANCE_ITEM 3703720,
xx3783 2675 $150.00 Nesta Archeron NEW_ISSUANCE_ITEM 037037202
Elain Archeron
003783 2676 $150.00 Jake Chambers NEW_ISSUANCE_ITEM 3703720
0003783 2677 $750.0 ABC Carpentry NEW_ISSUANCE_ITEM 03/03/202
003783 2678 $35.0 Office Pride NEW_ISSUANCE_ITEM 3/03/2021
w3783 2679 $26.97 edEx NEW_ISSUANCE_ITEM 0370372021
Delete
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9. If anissuance file needs to be deleted for any reason, click Delete to remove it. Deleting a file retains
item counts and totals as audit history.
Note: Files are only eligible for deletion if every item in the file is still available for matching status. If
just one item in the file has been paid, the file cannot be deleted.

Date Range

EFebruary 28, 2020~

Issuance Files Status

Y Filters >

Load Transaction Transaction
Date/Timel: C

ount Total View/Manage

DELETED

02/28/2020 14:23:52 8 $6,354.64

4.1 Multiple Payees
Check Positive Pay (Pro-Chex) can support customers with multiple payee names on issued items. The
system scores multiple names on a check against information provided in the issuance file.

e When you load an issue file into the system, the loaded file processes using the Issue Template set up
with Check Positive Pay (Pro-Chex). This allows for selection of a Multi-Line Payee Separator, a
character chosen to separate the names of multiple payees in the issue file.

e |If multiple payees are listed on a single line of a check, no action needs to be taken.

e [f multiple payees are listed on two or more separate lines of a check, the multiple payee separator
character (which should match the one designated in the template), must be used between each
name. In the example below, the Multi-Line Payee Name Separator designated in the Issue Template
is a pipe (|). The issue items shown are entered with the pipe separator between each name with no
spaces.

1 2 3 4 5 6 7 8 g 10 1 12 13 14 15 16 17]
1 Type Num Date Name Item Account Paid Amount Original Amount
2
3
4 Bill Pmt -Check 8384 ) [= Copeland 111141111 $65.55
r Nesta Archeron|Elain Archeron|Micah
5 Bill Pmt -Check 9385 06/07/2020 | Archeron 111111111 $600.00

e When the Issue File is loaded, the system separates the data before and after the character as
separate payees.

o Please refer to Section 3, Issue Templates, for more information about multi-line payee name
separators and how best to use this feature.

o Multi-line payee names cannot be utilized on accounts that have a Custom Payee Box enabled.
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4.2 Direct Send Issue File Recommendations

This feature allows you to send issue files to Trustmark via SFTP or another file transfer method, so that
Trustmark can load those issue files to Check Positive Pay (Pro-Chex) for processing. Please note the
following guidelines:

Subject Recommendation

File Naming There is a 100-character limit for issuance file names.
Direct Send Direct Send Issuance Files must be mapped to match the Default Template for Direct
Issuance File Load Issuance Files.
Mapping [ o |
Accounts for ASBank Client 1
Direct Send A direct send issuance file can be loaded and mapped to a different issue template if
Issuance File | that template name is included in the brackets with the client code, with a plus (+) sign
Mapping - in front.
Using a Example: Issuance_Date_[6789+CSV1].csv, YYYYMMDD_[Client Code].csv
different
template than
the default
Direct Send Account numbers must be included in the assigned issue template.
Issuance File
Mapping —
Account
Numbers
Direct Send The issuance date in the file must match the date format set up in the assigned issue
Issuance File | template. If a file is loaded where the issuance date format does not match the
Mapping — assigned issue template, the system updates the issuance items with the current date.
Issuance Date
Format
Direct Send This template must have mapping set up to accommodate all account configurations.
Issuance File e If one account is set for Payee Positive Pay, and one is set for Standard Positive Pay,
Template - then the Payee Name field must be mapped in the template, even though the
Account Payee Name is not a required field for accounts enrolled in Standard Positive Pay.
Configuration The template must be able to accommodate Payee Name if items are loaded for an
s account configured for Payee Positive Pay.
In the image below, issue items for two different accounts, each configured differently,
are shown.
e Account 12121212 is set for Standard Positive Pay and 12345678 is set for Payee
Positive Pay.
e The file will load without incident if not payee is included for the Standard Positive
Pay account because Check Positive Pay (Pro-Chex) knows the Payee Name is not
required for Account 12121212.

20



Pro-Chex Quick Reference Guide

//// Trustmark

e However, if the Payee Name is not provided for Account 12345678, the file will fail.

*DirectSend7[Client1].txt - Notepad
File Edit Format View Help
9596100012121212

9597150012345678 DoPayeenam(-{

Direct Send If a Direct Send Issuance is loaded for an account configured for Active Account
Issuance — Reconciliation, any items dated prior to the start date of the current reconciliation
Account period are automatically updated to the current date when loaded.

Reconciliation

—Issuance

Dates

Direct Send If you are configured to receive alerts, you will receive an alert email once the direct

Issuance Load
Alerts

send issuance file is transferred to the system and the file loads successfully.

e |[f the file loads with errors, the alert email informs Trustmark that the file load
failed. Trustmark checks the Issuance File Status page in Check Positive Pay (PRO-
CHEX) before taking action.

o If the Issue File Status column indicates the load failed, Trustmark reviews
the direct send issue file, corrects any problems, and resubmits the file.

o If the status column indicates edits_pending, click View to open the issue
file and make edits within PRO-CHEX.

4.3 Issuance Dual Approval

You may have the optional Issuance Dual Approval feature enabled. In this circumstance, loaded issue
files must be approved by a second user. If no second user is available to approve the file, you can
request that Trustmark approve the issue file.

Please refer to section 4.3 Issuance Dual Approval for more information about the Dual Approval process.

4.4 Disabled Stop Payments

When Trustmark has disabled stop payments, you cannot create new stopped issue items or modify
previously stopped issue items. Trustmark can, however, feed stop pay items from the core banking

system.

e Ifyouloadan
issue file with
serial numbers
on which
Trustmark has
loaded a stop
pay, the system
will not accept
the file.

< Back to Status

File Status

Queued

Account Number

XXXX3232

Serial Number

100947

100948

Processed

Amount

$475.00

$400.00

CHC1 Issue 0304-001.xlsx

Approved / Rejected Completed Deleted

Load Date: 03/04/2021 11:36:51 EST

Payee Name Status Issuance Date

Michael York FICATION 03704/2021

INELIGIBLE_FOR_M

Elizabeth Tudor 03/04/2021

INELIGIBLE_FOR_MODIFICATION
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5. Issue Warehouse

Check Positive Pay (PRO-CHEX) allows you to see the status of all issued items. Authorized users can
modify items in the Issue Warehouse. You can use the Issue Warehouse to search for issued items or
specific account using the filtering options available.

1. Within the Check Positive Pay (Pro-Chex) module, click View > Issue Warehouse.

PRO-CHEX ®Managev #Perfform~ JIReports~ EView ~ Change Module v

Issue File Status
Issue Warehouse | <=

We | CO m e Transaction History

Item Lookup

—

Please use the above menu to select an action i .
Reconciliation Periods

The Issue Warehouse page displays.

Date Range
Issue Warehouse & Jul 01, 2023 - Jul 31, 2023 +

Y Filters >

ItemID  Account Number Serial Number Payee Name Issue Type Match Status Amount Load Date/Timeli Issuance Date  Update
> 4261385 003333 511247 ISSUED OUTSTANDING $698.00 07/14/2023 2:33 PM EDT 06/30/2023 7
> 4261373 x0ox3333 511233 ISSUED OUTSTANDING $2,001.00 07/14/2023 2:33 PM EDT 07/24/2023 7
> 4261372 03333 511232 ISSUED OUTSTANDING $200.00 07/14/2023 2:33 PM EDT 06/30/2023 7

2. Click Date Range to filter the date range of items displayed.

- Date Range

Issue Warehouse i Jul 27, 2023
¥ Filters Start Date’ End Date’ R —_—
07/27/2023 07/27/2023
20 transactic Today
i July 2023 August 2023

ROW sy Mo Tu We Th Fr Sa Su Mo Tu We Th Fr sa  Yesterday
I 25 26 27 28 29 30 1 12 3 4 5 Llast7Days
2 3 4 5 6 7 8 6 7 8 9 10 1 12 ThisMonth
9 10 11 12 13 14 15 13 14 15 16 17 18 19 R——
Account Serial B o a1 2 s 22 a3 2 s 2 sl

ItemID  Number Number Payee Name e 17 s s 20 e e Custom

3222 sfge s 7w w012
> 4261501 oomxd680 7534 QOliver Orville
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3. Click Filters to narrow the search results.

Date Range

Issue Warehouse & Jul 27, 2023+

Y Filters v

Account’ Match Status Date Range Filter Type

Any v Issue Date ® Load Date
Amount Amourtt Range Issue Type
s Any v
Serial Number
Apply

A window containing additional search criteria displays.

Field Description

Account Used to enter an account name of the last four digits of the account number.

Match Status | Paid — An item for the issued item was presented and paid.

Returned — An item for the issued item was presented and returned.

Outstanding — No item has been presented for the issued item and it remains outstanding.
Amount Enter a specific amount for the transaction.

Amount range — Click the hyperlink above Amount to enter an amount range or a
maximum or minimum amount of transaction.

Min Amount — Minimum dollar amount of transaction.

Max Amount — Maximum dollar amount of transaction.

Issue Type Issued — The check has been issued for payment.

Voided — The check has been voided by the maker.

Stopped — The check has a stop payment placed on it.

Serial Enter the item serial number for a specific issued item.

Number Serial Number Range — Click the hyperlink above Serial Number to enter a serial number
range or a maximum or minimum serial number.

Min Serial # - Minimum serial number.

Max Serial # - Maximum serial number.

4. Once search criteria are selected, click Apply to narrow search results.

e Search results are displayed on pages of 25 items.

e |If the search contains more than 25 issue items, results are displayed on multiple pages.

e Use the navigation buttons at the top of the search results to review 79 transactions totaling $61,748.44
all results.

Rows 1 - 25 of 79.
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Account

ItemID Number

> 2276362 o1l

Load
Date/Timeli

Issuance
Date

Issue
Type

Serial

Number Payee Name Match Status Amount Update

9263 ISSUED OUTSTANDING $6,130.00 05/29/2020 10:04:33

EDT

Citizens Union Bank (v) 05/28/2020 s

The table below describes the search results.

Field Description

Item ID Number assigned by Check Positive Pay (Pro-Chex) when a file is loaded.
Account Displays the account number for an item.

Number

Serial Displays the serial number of the issued item.

Number

Payee Name Displays the name of the payee for the item.

Issue Type Issued — The check has been issued for payment.

Voided — The check has been voided by the maker.
Stopped — The check has a stop payment placed on it.

Match Status

Paid — An item for the issued item was presented and paid.
Returned — An item for the issued item was presented and returned.
Outstanding — No item has been presented for the issued item and it remains outstanding.

Amount Displays the dollar amount for the issued item.

Load Date (MM/DD/YYYY) and time (HH:MM:SS) the item was loaded.
Date/Time

Issuance Date | The date of the issued item.

Update Click the pencil icon to update the item’s Amount, Status, or Issuance Date.

e IfIssuance Dual Approval is enabled for a client, any updates made to issue items
through the loading, manual entry issue, or modifying issue items in the Issue
Warehouse are passed through Issuance Dual Approval to be reviewed and approved
by a secondary user.

5. Click the arrow next to the Item ID to view more detail on each issued item. The information shown
in this drop-down is an audit history of all activity on the issue item.

Account

ItemID  Number

W 3393032 xxxx3579

Status Payee

ISSUED

Richard Canova

Load
Date/Timeli

Issuance
Date

Issue
Type

Serial

Number Payee Name Match Status Amount Update

ISSUED OUTSTANDING 353000  04/22/202212:13 PM

EDT

113687 Richard Canova 04/22/2022 p

Amount Issue Date Updated By Updated Date/Time

$30.00 04/22/2022 sdelaerel 04/22/2022 12:13 PM EDT
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The table below describes the items visible once the view has been expanded.

Field Description

Status Issued — The check has been issued for payment.
Voided — The check has been voided by the maker.
Stopped — The check has a stop payment placed on it.

Payee Displays the payee name of the issue item.

Amount Displays the dollar amount for the issued item.

Issue Date Date of the issued item.

Updated By User who updated the issue item.

Updated Date and time this issued item was updated.

Date/Time

5.1 Modifying Issue Items

Issue items can be modified by users with a Load Issue File or Manual Issue Entry privilege. Issue items
can only be modified if the Match Status = Outstanding.

1. Click the edit pencil button under the Update column to update the issued item.

Account Serial Issue Load X " Issuance
ItemID  Number Number Payee Name Type Matchstatus  Amount  Date/Timeli Date Update
> 2276362 cox1111 9263 Citizens Union Bank (v) ISSUED  OUTSTANDING $6,130.00 05/29/202010:0433  05/28/2020 | ,
EOT
The Update Issue Item pop-up window displays.

Update Issue Item
Serial Number Amount Payee Name’ Status Issuance Date

9263 6130 Citizens Union Bank (v) ISSUED v s 05/29/2020

Save
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The table below describes the Update Issue Item screen.

Field Description

Serial Check serial number.
Number e This cannot be updated on an existing issued item.
Amount Amount of the issued item.

e The amount cannot be updated.

Payee Name The name of the Payee associated with the specific issued item.

e The payee name can be updated.

Status Issued — The check has been issued for payment.

Voided — The check has been voided by the maker.

Stopped — The check has a stop payment by the maker.

e If Trustmark disabled stop payments in the configuration, Stopped will not be an option
in the drop-down menu on this pop-up screen.

Cancelled — The check is being cancelled by the maker. See next paragraph.

An outstanding issue item can be updated to Cancelled status.

e Only outstanding issue items have the option to be changed to Cancelled.

e Once the issue item is updated to Cancelled, the item disappears from all views except Item Lookup,
Active Reconciliation (if enabled), and Audit Report for historical purposes.

Update Issue Item
Serial Number Amount Payee Name’ Status Issuance Date
113687 30 Richard Canova ISSUED v B 04/28/2022
VOIDED
CANCELLED
Save
2. Click Save.

Issue updated.

A copy of the Issue Warehouse can be downloaded by clicking Download as CSV at the bottom of the
Issue Warehouse screen.
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6. Iltem Lookup

Check Positive Pay (PRO-CHEX) provides you with the ability to look up all recorded data on individual
issued items with the Item Lookup feature.

1. Within the Check Positive Pay (Pro-Chex) module, click View > Item Lookup.

PRO-CHEX ®Manage~ . Perfform~ JiReports~ EvView~ Change Module ~
Issue File Status
Issue Warehouse
We I CO m e Transaction History
. Item Looku —
Please use the above menu to select an action [ pece ,p - ]
Reconciliation Periods

The Item Lookup page displays. All fields on this page are mandatory.

Iremn Lookup

Account’ Serial Number

- not selected - v

The table below describes the fields on the Item Lookup page.

Field Description

Account Select to display a list of your accounts.
Serial Enter the serial number of the item.
Number

2. Once search criteria are selected/entered, click Apply to complete the Item Lookup.
e Search results for the item display.
e Within this screen, the lifecycle of the issued item is displayed.
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Search results:

Item Lookup
Account’ Serial Number
The One and Only - xxxx1111 (ASBank Client 1 - ASBC1) v 11548
Account Number: oo 1111 Serial Number: 11548 View Check Image
Transaction Date: 04-15-2021 Original Serial Number: 11548 Exception Reason: Amount Mismatch
Payment Date: 04-15-2021 Original Amount: $27.00 Payee Match Score: Error analyzing payee name
Transaction ID: 45566 Issuance Payee Name: FedEx Disposition Created: 04/15/2021 15:00:00 EDT
Debit Amount: $27.00 Issuance Serial Number: 11548
Current Status: Pay-System Issuance Amount: $180.00
Issuance Status: ISSUED
Transaction Date: 04-15-2021 Original Serial Number: 11548 Exception Reason: Duplicate Presentment
Payment Date: 04-15-2021 Original Amount: $127.00 Payee Match Score: Error analyzing payee name
Transaction ID: 45567 Issuance Payee Name: FedEx Disposition Created: 04/15/2021 15:00:00 EDT
Debit Amount: $127.00 Issuance Serial Number: 11548
Current Status: Pay-System Issuance Amount: $180.00
Issuance Status: ISSUED
Issuance Date: 04/15/2021 Update By: mfleetwood1 Payee Name: FedEx
Updated Date/Time: 04/15/2021 13:34:17 EOT Transaction Id: 45566 Match Status: PAID
Load Date/Time: 04/15/2021 13:34:17 EDT Issue Type: ISSUED Amount: $180.00

7. Other Options Prior to Item Presentment

If you need to make changes to an item prior to item presentment, there are two options within Check
Positive Pay (Pro-Chex):

e |tems originally issued are updated to Voided.

e Information for an existing item, such as changes in amount and/or payee are overwritten.

7.1 Modifying Issue Items
Issue Items can be modified in the Issue Warehouse. Refer to Section 7.2 Manual Re-Entry.
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7.2 Manual Re-Entry

To change individual items previously submitted, you can overwrite the previous item as follows:

A

1. Within the Check Positive Pay (Pro-Chex) module, click Perform > Manual Issue Entry.

PRO-CHEX ke ] Manage ~ & Perform ~ i Reports ~

Issue File Load

l Manual Issue Entry Iq—

Wel CO m e Transaction Approval

Active Reconciliation

Please use the above men
Statement Balance Entry

Paid No Issue Match

2. The Manual Issuance File Entry page displays. For definitions of the fields available on this screen,
refer to Section 5.1 — Modifying Issue Items.

Manual Issue Entry

Account’ Auto populate next check number: 2

Row Serial Number Amount Payee Name’ Status Issuance Date

05/29/2020

© Click any row to select that row for editing

Save

3. Create a Manual Entry for the item to be changed. The serial number must match the previously
submitted item.

o Fill out all fields, updating the fields to be overwritten with the correct information.
e Click Save.

The Manual Issuance File Detail page displays.

7.3 File Reloads

To change multiple items that were previously submitted, use the Issue File Load function to reload and
overwrite them in the Issue File.

1. Once your issue file is prepared with all items to be overwritten, including the corrected information
in the appropriate fields, upload the Issue File.
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Note: Prior to item presentment, these changed/overwritten items can be viewed in the Issue
Warehouse. Refer to Section 5 — Issue Warehouse for information on how to access the Issue
Warehouse.

2. Once within the Issue Warehouse screen, click the arrow (>) next to the Client Code to view more
detail on each issued item. The information in this drop-down is an audit history of all activity on the

issue item.
< Back to Status MANUAL_1614805777127
File Status
Queued Processed Approved Completed Deleted

@ view item: 1 Item totaling $525.00 Load Date: 03/03/2021 16:09:37 EST
Rows 1-10of 1.
Account Number Serial Number Amount Payee Name Status Issuance Date
w3783 100945 $525.00 Moe Green AVAILABLE_FOR_MATCHING 03/03/2021

Delete

As shown in the next image, three issue items have been updated/changed. The updates/changes from
the most recent entries have overwritten the previously loaded issue item.
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Date Range
Issue Warehouse =
Euly 21, 2020~
Y Filters >
Account Serial Issue Load ) . Issuance
ItemID Number Number Payee Name Type Match Status Amount Date/Timeli Date Update
W 227BBB1 0003210 3484 FedEx VOIDED QUTSTANDING $26.97 07/21/2020 08:55:38  07/21/2020 s
EOT "
Status Payee Amount Issue Date Updated By Updated Date/Time
VOIDED FedEx £26.97 07/21/2020 Sallyacmel 07/21/2020 13:08:19 EDT
ISSUED FedEx $£26.97 07/21/2020 SallyAcmel 07/21/2020 08:55:38 EDT
> 2278880 0003210 3463 Office Pride ISSUED QUTSTANDING £35.00 07/21/2020 08:55:38 07/21/2020 s
EDT -
W 2278879 oox3210 3492 ABC Carpentry ISSUED OUTSTANDING £850.00 07/21/2020 08:35:38 07/21/2020 ya
EDT -
Status Payee Amount Issue Date Updated By Updated Date/Time
ISSUED ABC Carpentry $850.00 07/21/2020 SallyAcme1 07/21/2020 13:09:50 EDT
ISSUED ABC Carpentry $750.00 07/21/2020 SallyAcmet 07/21/2020 08:55:38 EDT
W 2278878 0003210 3491 Jake Chambers STOPPED OUTSTANDING $150.00 07/21/2020 08:55:38 07/21/2020 Vs
EDT :
Status Payee Amount Issue Date Updated By Updated Date/Time
STOPPED Jake Chambers $150.00 07/21/2020 SallyAcmet 07/21/2020 13:08:44 EDT
ISSUED Jake Chambers $150.00 07/21/2020 SallyAcmel 07/21/2020 08:55:38 EDT

8. Managing Check Presentment

The primary objective of Check Positive Pay (PRO-CHEX) is to give users the opportunity to make pay
and/or return decisions on checks presented for payment on accounts enrolled for the service. The
decision function is performed in the Transaction History screen.

8.1 Transaction History

Check Positive Pay (PRO-CHEX) provides a function for you to search and view the status of checks

presented on enrolled accounts, and to make decisions on presented items.

e You can use Transaction History to search for presented check items for a specific account using the
filtering options available. The default filter setting is Exceptions Only. Additional transactions may be
available to view and decision (such as reverse positive pay items); however, they are not displayed
unless the Exception filters option is set to Show All Transactions.

e Transactions are stored for 12 months.

e The Transaction History user privilege must be enabled to access this screen.

o |f the user has been granted the Change Status user privilege and the transaction is available to
decision, the Pay and Return buttons will be available for use.
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e Transactions that will be paid will have green shading as a background.
e Transactions that will be returned will have yellow shading as a background.
e Transaction status cannot be changed after the end of day cut-off time.

8.1.1 View Transaction History

1. Within the Check Positive Pay (Pro-Chex) module, click View > Transaction History. This page displays
all current-day transactions for all accounts to which the user has access.

Date Range
Transaction History i )ul 27, 2023+
Y Filters >
3 $5
Transaction ID Account Number Serial Number Credit  Debit Current Status Dateli Change Status Exception
> 1260078 04680 7534 $900.00 Pay-System 07/27/2023 s
> 1260077 0004680 7533 $30.00 Pay-System 07/27/2023 2
> 1260076 004680 7532 $300.00 Pay-System 07/27/2023 $
2. Click Date Range to filter the date range of items displayed.
Date Range
Transaction History i Jul 27, 2023«
0772712023 07/27/2023
Y Filters Today
July 2023 August 2023

nsac Su Mo Tu We Th Fr Sa Su Mo Tu We Tn Fr Sa Yesterday
Row 25 26 27 28 29 30 1 1 2 3 4 s last7Days
I 2 3 4 5 6 7 8 6 7 8 9 10 1 1 This Month
9 10 11 12 13 14 18 13 14 15 16 17 18 9
Last Month
16 17 18 19 20 21 22 20 21 22 23 24 25 26
Custom
Transaction ID Account Number Serial Number Credit 322 6w 272833 n 1 2

> 1260078 200X4680 7534 E m Cancel

3. To narrow the search results, click Filters. A window containing additional search criteria displays.

Date Range
Transaction History 27,2023

Mass Pay & Issue Payee Review (16)

Y Filters v
Account’ Exceptions Default Items.
Amount A farge Exception Type

Serial Number Pending Dual Approval

PayType Transaction Type

Transaction 1D

32



Pro-Chex Quick Reference Guide

//// Trustmark

N

The table below describes the fields in the Transaction History page.

Field Description

Account

Used to enter or select an account name or the last four digits of the account number to
view transactions for one specific account.

Amount

Used to enter a specific dollar amount for the transaction.

Amount Range — Click the hyperlink above Amount to enter an amount range or a
minimum or maximum amount of transaction.

Min Amount — Minimum dollar amount of transaction.

Max Amount — Maximum dollar amount of transaction.

Serial
Number

Type the item serial number for a specific issued item.

Serial Number Range — Click the hyperlink above Serial Number to enter a serial number
range or a minimum or maximum serial number.

Min Serial # - Minimum serial number.

Max Serial # - Maximum serial number.

Positive Pay
Type

Defaults to Any. Select Positive Pay Type to filter by:

Standard — Transactions on accounts set up for Standard Positive Pay.
Reverse — Transactions on accounts set up for Reverse Positive Pay.
Blocked — Transactions on accounts set up for Block Positive Pay.
None — Transactions on accounts set up for No Positive Pay.

Exceptions

Defaults to viewing only Exceptions. Select Exceptions to filter by:

Exceptions Only — Only exceptions display.

Show all Transactions — Exceptions and non-exceptions display.

No Exceptions — Only non-exceptions display.

You can set an option to be the default for future filtering by clicking the Default checkbox
once the selection is made.

Exception
Type

Displays the standard exception reason labels; however, Trustmark can customize these
during implementation. What is seen in the documentation may differ from what you see
in service.

Pending Dual
Approval

If Trustmark enabled Decision Dual Approval, this field may be available in the filter
window. You can select from the drop-down to filter transactions based on whether they
are pending approval. The default is set to Show All.

Yes — displays only transactions pending approval.

No — displays only transactions not pending approval.

Transaction
Type

Defaults to Any. Select Transaction Type to filter by:
Check — Check transactions only.
Deposit — Deposit transactions only.

Transaction
ID

A unique number assigned to the transact=ion when loaded.

Items

Defaults to Any Items. Click the drop-down to select one of the following:

Any Items — Includes all items, including client pay and adjust items.

Adjusted Items — Checks paid by a client user and either the amount and/or serial number
was adjusted.

Transaction
Status | Pay

Pay-System — The system’s default is pay this check. If you take no action before end of
day, the check pays.
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Pay-Fl — The check was paid by Trustmark. In the case of payment items loaded by
Trustmark in a Force Pay status using the standard Force Pay template, the items display
with the Trustmark Pay status and are ineligible for changes to the transaction status.
Pay-User — A user changed the transaction status from Return to Pay.

Pending-Pay — The check was paid by the user but awaits approval or rejection because
you are enrolled in Decision Dual Approval.

Transaction
Status |
Return

Return-System — The system is set to default return this check. If the user takes no action
before end of day, the check is returned.

Return-Fl — The check was returned by Trustmark.

Return-User — A user changed the transaction status from Pay to Return.

4. Once search criteria are selected, click Apply to narrow your search results.

e Search results display in pages of 25 items.

e [f the search contains more that 25 issue items, the results display on multiple pages. Use the
navigation buttons at the top of the search results to review all results.

Summary debit and /or credit transaction totals are displayed at the top of the screen above the
navigation buttons.
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5. Click the arrow next to the Transaction ID to view more details on each issued item. The information
shown is an audit history of the activity on the issue item.

Detail results:

Date Range

Transaction History FMay 4, 2023
viay 4, -

Y Filters >

2
Transaction ID Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception
v 1157794 X000X4680 7009 $90000 Pay-System 05/04/2023 00
Positive Pay Type: payee Payment Date: 05/03/2023 Adjust Motes (0)
Issuance Payee Name: Oliver Orville Loaded Exception Reason: Issuance Amount Mismatch
Issuance Serial Number: 7009 Payee Analysis: Fail

Issuance Amount: $933.00
Issuance Date: 05/04/2023
Original Serial Number: 7009

Original Amount: $900.00

v 1157793 XOA680 7008 $30.00 Return-Fl 05/04/2023 @Pay [:]
Positive Pay Type: payee Return Date: 05/04/2023 6:00 PM EDT st Motes (0)
Issuance Payee Name: Natalie North Return Reason: Early Presentment
Issuance Serial Number: 7008 Loaded Exception Reason: Early Presentment
Issuance Amount: $30.00 Payee Analysis: Pass

Issuance Date: 05/04/2023
Original Serial Number: 7008

Original Amount: $30.00

The table below describes the fields in the Transaction History:

Description
Positive Pay Indicates the type of positive pay for which the account is set.
Type e Types include Standard, Reverse, and Payee.
Issuance Name of payee submitted with the transaction presented for payment.
Payee Name
Issuance Serial number on the uploaded issued item.
Serial
Number
Issuance Amount on the uploaded issue item.
Amount
Issuance Date | Date the issued item uploaded.
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Original Serial

Serial number submitted with the transaction presented for payment.

Number
Original Amount submitted with the transaction presented for payment. This number may be
Amount different than displayed in the top line. For example, an item was adjusted in pre-scrub by

Trustmark or if Trustmark is allowing you to adjust.

Payment Date

Date listed within the transaction file.

Loaded This user documentation displays standard exception reason labels. Because Trustmark
Exception can customize these during implementation, what is seen in the documentation may differ
Reason from what you see in the service.

Originally In the case of Duplicate Presentment exceptions, the Originally Cleared Date displays the
Cleared Date | cleared date of the originally presented item.

Originally In the case of Duplicate Presentment exceptions, the Originally Cleared Amount displays
Cleared the cleared amount of the originally presented item.

Amount

Originally In the case of Duplicate Presentment exceptions, the Originally Cleared Status displays the
Cleared status of the originally presented item.

Status

Payee Displays as Pass or Fail based on payee scoring.

Analysis

Return Date

Date the item was returned.

Return Reason for the return.
Reason o Click the Return Reason hyperlink to open a pop-up window to select a different return
reason as needed.
v $ o o
When an item is in Pending-Pay status and awaiting approval or rejection (because the
account is set up for Decision Dual Approval), the Return Reason hyperlink is disabled.
Adjust Allows you to adjust a serial number from the value presented to a new value and/or the
amount from the amount presented to a new value.
Notes Allows both Trustmark and users to make notes regarding a transaction in Pay or Return

status.
e The Notes button displays the number of Note entries on a transaction.
o Click Notes to enter information regarding a transaction.
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8.2 Change Transaction Status
If you are granted the Change Status user privilege and the transaction is eligible for a decision, a Pay or
Return button displays for use.
e [f the transaction is not eligible for a decision, the button displays as Ineligible.
o Reasons for the Ineligible message can include the item being a deposit, already decisioned,
left at the system default, or the item is a Force Pay item loaded by Trustmark using the
Standard Force Pay template.

8.3 Change Status: Pay

If the Current Status on an issued item is set to Return, you can opt to change the status to Pay if you
determine it should be paid.

e (Click Pay in the Change Status column.

. z
Transaction ID Account Number Check Number Credit  Debit Current Status Dateli Change Status Exception

v 7740764 01115 7345 $900.00  Return-User 04/07/2023 -]

The Change Status button changes to Return, and the Current Status column updates to Pay-User.

8.4 Change Status: Return

If the Current Status on an issued item is set to Pay, you can change the status to Return if you
determine it should not be paid.

e (Click Return in the Change Status column.

v 7740763 oo1115 7344 $30.00 Pay-System 04/07/2023 [:]

The Check Return Reason pop-up window displays.
e Select the appropriate reason for the check return and then click Save. The system will display a
success message.

The Change Status button changes to Pay, and the Current Status column updates to Return-User.

The list of return reasons displayed below are the system default.
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Select a check return reason:

Amount Incorrect
Dugplicate
Fraudulent

Prior Stopped

Prior Viold

Refer to Maker
Serial # Incorrect
Signature Irregular
Signature Missing

Stale Dated

The table below describes the return reasons.

Description

Amount Incorrect Dollar amount is incorrect.

Duplicate The item has already been presented.

Fraudulent Fraudulent item.

Prior Stopped This item has a sop payment placed on it.

Prior Void The item was previously voided.

Refer to Maker Refer to the maker of the check.

Serial # Incorrect The serial number on the item is incorrect.

Signature Irregular The signature does not match.

Signature Missing The item is missing a signature.

Stale Date The presented item has a date greater than the number of stale days
allowed on the corresponding issued item.

Suspect Item — Review Required | The item is suspicious and possibly fraudulent — please review further.

8.5 Duplicate Presentment

For transactions that list the Duplicate Presentment exception reason, you can view the duplicate and
previously presented check items to visually inspect the checks.

o (Click Duplicate Presentment to open the Check Image window.

Transaction ID Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception
v 1158611 X0004680 7114 $900.00 Pay-System 05/22/2023 C

Positive Pay Type: payee Payment Date: 05/22/2023 Adjust Notes (0

Issuance Payee Name: Oliver Orville Loaded Exception Reaso

Issuance Serial Number: 7114 Originally Cleared Date: 05/21/2023 8:00 PM EDT

Issuance Amount: $933.00 Originally Cleared Amount: $900.00

Issuance Date: 05/22/2023 Originally Cleared Status: Paid

Original Serial Number: 7114 Payee Analysis: Fail

Original Amount: $900.00
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The Check Image window displays the Duplicate Exception item and Previously Presented item so you

can visually inspect both items.

Check Image

1
Check Number /114 |
oete _MAY 22, 2023 !

I
T Dellars :
vemo LoN: 46102680 S DelLagee !
P U RIS S I S SIS MRS UISS SEES S UGS S S S S SSg s g g S i S e e -
nig2evenL g ¢Lga02LE80" 74 AL 0000050000
________________________________ -
o Void **
v Check Number 7114 :
islc Date _MAY 22, 2023 :

: 1550 ;

Amoun!
~7 I L
Memo I’”: ‘f‘)dus S DelLAERE
NG 0 0 o e -
niz2a?eLnLing 2Le802LEB0" 7?4 1L 0000090000

Click Show Back at the bottom of the screen to view the back of the checks.

The backs of the Duplicate Exception item and the Previously Presented item appear. You can visually

inspect the images.

e Click Show Front to return to the front view of the checks.
e C(lick Close to return to the Transaction Warehouse view.

Check Image

i
E

yeuno} abew
ZZISOEZ0Z
Aug wsodaq Jo4

g MDY
Shelas

311 e

Presentes

XirWars LLC

S HOINUOIRLOITY Ol
Sres
jeuno) abew)
ZZ/S0/EZ0Z
Auo nsodagq 104
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In the expanded transaction view, both the current and previously presented check data displays for

comparison.
Transaction ID Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception
v 1158611 04680 7114 $900.00 Pay-System 05/22/2023 C
Positive Pay Type: payee Payment Date: 05/22/2023 Adiust Notes (0

Issuance Payee Name: Oliver Orville Loaded Exception Reason: Duplicate P
Issuance Serial Number: 7114

Issuance Amount: $933.00 Originally Cleared Amount: $900.00

Issuance Date: 05/22/2023 Originally Cleared Status: Paid

Original Serial Number: 7114 Payee Analysis: Fail

Original Amount: $900.00

Originally Cleared Date: 05/21/2023 8:00 PM EDT

A copy of the Transaction History can be downloaded by clicking Download as CSV at the bottom of the

Transaction History screen.

8.6 Optional Actions
8.6.1 Confirm Paying Exceptions

When the first exception is triggered on a presented item, additional validations are not performed.
e [f the system detects a user pay decision on a check for which additional validations were not
performed (such as payee name analysis, which is the last validation to occur), an image of the check

is presented to allow you to visually inspect the check.
e You must click Confirm to finalize the pay decision.

Confirm Check

______________________________________ -
James C. Mornson
! 12345 AmyWhere Cice T.e.ssoa:ge’.:n Check Number 13747 !
| Your City, State 12345 Nanaguiiible Detp mll qu MM |
I 1
1 P |
[ . I
Pay To the 0 : H
| Order Of anNce :$ 2400 |
! e mmeann :
I 1
s amount _TWenty €our and No cents |
I - bollars |
I
I

. |

e e e e e e e e e e e e - —

niggd?eLbL bl 4357913579 11437L7 000000 2LOO.

Exception Reason: Issuance Payee Mismatch
Issuance Serial Number: 113747 Issuance Amount: $24.00

Issuance Payee Name: Advanced
Medical

s m

Amount and Serial Number may be adjusted after Confirm

Payee Match Score: 13
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e If you decide to pay an item that is set to return, a pop-up window displays to confirm the action you
wish to take. The window displays an image of the check and other details for you to review before
confirming to pay the item.

o Click Pay to pay a check.

e A pop-up window with check information displays for your review.

e Once the information presented is reviewed, you can click Confirm so that the check is paid or Cancel
so that the check is returned.

8.6.2 Pay and Issue

This enterprise feature must be enabled by Trustmark and the user must have the Manual Issue Entry,

Load Issue File and Change Transaction Status user privileges.

e |f an exception is triggered because no issue item exists and you pay the check, you are presented
with a link to tell the system to create a matching issue item.

e |f Client Pay & Issue is enabled, the expanded view on the item displays an Add Issue button. Click
the Add Issue button to proceed.

v 20537 oo 111 9718 $36.10 Pay-System 07-21-2020 (1]

Positive Pay Type: Payee Payment Date: 07-20-2020

Add Issue
Original Serial Number: 9718 Exception Reason: No Issue Item

Original Amount: $36.10

The Add Issue Item pop-up displays. The Serial Number, Amount, and Status fields are locked from

editing.

e (Click in the Payee Name field to enter a payee name, or in the Issuance Date field to select the date
of the issued item and click Save.

Add Issue Item:

Serial Number Amount Payee Name’ Status Issuance Date
9718 36.1 Office Pricc_-| ISSUED & 07/21/2020
Save

A success message displays.
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Note:

Iltems with duplicate presentment exceptions will not present the option to Add Issue from within

Transaction History, as another item has been presented and paid with that serial number.

o The system will not allow the Add Issue function for a check with no serial number.

8.6.3 Mass Pay and Issue

This enterprise feature must be enabled by Trustmark and the user must have the Manual Issue Entry,
Load Issue File and Change Transaction Status user privileges.

If you are on standard or payee positive pay, you should always enter or load issue items prior to
distributing checks to avoid denial of payment at the teller line. However, if you fail to enter or load
issue items and many No Issue exceptions occur as a result, this feature allows you to have issue
items systematically created for each item without clicking each exception item individually, and to
pay all items at once instead of individually.

If Mass Pay & Issue is enabled, click the Mass Pay & Issue button at the top of the Transaction
History screen.

. . Date Range
Transaction History iy 2! éo
—

Y Filters ?

When clicked, the Mass Pay & Issue page displays a list of issue items with checkboxes for each.

Mass Pay & Issue

< Back

Select

[all | none]

Account Number Serial Number Amount Current Status

Ll 01111

] w1111 9727 §52.15 07-21-2020 Pay-System

Individual issue items can be clicked for Mass Pay & Issue. Once all issue items are selected, click Pay
and Issue Selected at the bottom left of the screen.

Pay & Issue Selected - Pay & Issue All 29

//// Trustmark
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To approve all issue items to Pay and Issue, click Pay & Issue All [number].

e The Mass Pay & Issue page displays 25 issue items per page.

e The Pay & Issue All [number] button pays and issues all available issue items on all pages. The button
displays the total number of issue items available.

The Confirm Mass Pay & Issue pop-up window displays.
e (Click Cancel to return to the Mass Pay & Issue screen or Confirm to continue.

Confirm Mass Pay & Issue

Mark 29 checks as paid and add issue item

Click Cancel to return or Confirm to continue

A success message displays:

5 paid and issues added

Note:

e The Mass Pay & Issue button is also available within the Consolidated Transaction History screen.
e The system does not allow the Add Issue function for a check without a serial number.

o Add Issue is not available for transactions in Reverse Positive Pay accounts.

8.6.4 Pay & Adjust

This enterprise feature must be enabled by Trustmark and the user must have the Manual Issue Entry,

Load Issue File and Change Transaction Status user privileges.

e Trustmark may allow users to adjust a serial number from the value presented to a new value and/or
the amount from the amount presented to a new value.

e |f Client Pay & Adjust is enabled, an Adjust button displays under the Pay button.

e Click Adjust.

2
Transaction ID Account Number Check Number Credit  Debit Current Status Dateli Change Status Exception
v 7740739 01115 7320 $2,800.00 Pay-System 04/07/2023 0
Positive Pay Type: payee Payment Date: 04/07/2023 Adjust | pmmmbremes

Issuance Payee Name: A Loaded Exception Reason: Payee Discrepancy
Issuance Check Number: 7320 Payee Analysis: Fail

Issuance Amoun

Issuance Date: O«

Original Check Number: 7320

Original Amount: $2
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The Adjust Check Amount and Serial Number pop-up screen displays.

e The available fields are contingent upon what Trustmark has enabled.

e In this example, the Adjust screen includes check amount and serial number.
e Enter the correct Check Number and/or Amount and click Save.

Adjust Check Amount and Serial Number:

Check Number:

Amount:

The Transaction History page displays the adjusted serial number and/or adjusted amount.

Transaction ID Account Number Check Number Credit Debit Current Status Dateli Change Status Exception

v 7740739 001115 7320 $2.800.00 Pending-Pay 04/07/2023 o
Type: pay Payment Date: 04/07/2023 i

Notes

ason: Payee Discrepancy

When the serial number is changed using Pay & Adjust, any issuance items previously matched and used
by this transaction are marked as Available for Matching, releasing the issuance for matching by future
transactions. In addition, issuance matching is performed using the new serial number and if any
issuance is found it is marked as Used in Matching.

8.7 Review Payee

Although payee analysis is a good technology, it is not perfect technology. The Review Payee

functionality allows users to visually inspect presented items to ensure fraudulent transactions that may

not have triggered exceptions are identified.

o |f Payee Positive Pay is configured by Trustmark, the Review Payee feature is available in Transaction
History.

e Review Payee allows users to easily view non-exception items for transactions on accounts enrolled
in Payee Positive Pay.

e From within Transaction History, the Payee Review button displays at the top of the screen with the
total number of non-exception items available for review in parentheses.

e (Click Payee Review to proceed.
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. . Date Range
Transaction History -
Eapril 7, 2023~
Mass Pay & Issue Payee Review (5)
Y Filters >
lebit transa ) $5:
Rows 26 - 50 of 70
1 n 3
Transaction ID Account Number Check Number Credit Debit Current Status Datel: Change Status Exception
» 7740739 %00x1115 7320 $2,800.00 Pending-Pay 04/07/2023 o
> 7740738 30001115 7319 $293.93  Pay-System 04/07/2023 [1]

The Payee Review screen displays all current day non-exception transactions for all accounts to which

the user has access.

< Back

Payee Review

Y Filters

Transaction Information

Transaction ID:
Account Number:
Check Number:
Amaunt:

Issuance Payee:

)
1-50f5
Image Change Status
T740710
ox O, Mawtinon >
wox1115 . e Test Capture Only
‘o City, State 12348 \llr.vh.'_u’l:ahl.c
7291 OATE CHEGK NO AMGUNT
. 0470712023 7201 $ 6sss
$65.55

Mike Mechanics

Mike Mcechanic

Sixty five and 55 cents

ISN: 102202195

10440000450

* Void ** Void ** Void **

S DeLacre

AAbRAAAAA5*T29) SO00D0D0O0BSSSS

Transaction 1D: 7740709 )
s . Mucrvinon
Account Number: xo0ox1115 prerrip N Test Capture Only
Vi City, State 12343 Nor-Negotiable
Check Number: 7290 ‘ DATE T checkwo___ | AMOUNT
[ 04707 /2023 7390 |$ 90,00
Amount: $90.00
Issuance Payee: UPS Pay Uprs i
&
.T" Ninety and No cents

The table below describes the fields displayed on the Payee Review screen.

Description

Check Number
Amount

The check number presented for payment.
The dollar amount of the check.

Issuance Payee
Image View
Change Status

Name of payee submitted with the issuance presented for payment.
Used to display the front image of the check for review.

The Return button is available for the user to change the status of the transaction to
Return.
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To narrow the review screen results, click Filters. A window containing filter criteria displays.

Payee Review

T Filters v

Account’ Serial Number Serial Number Range

Any v

Amount Amcun: Range

5

The table below describes the fields displayed on the Payee Review filtered screen.

Description

Account Select account or enter an account name or the last four digits of the account number to
view transactions for a specific account.

Amount Enter a specific amount for the transaction.

Amount range — Click the hyperlink above the Amount field to enter an amount range
or a maximum or minimum amount of transaction.

Min Amount — Minimum dollar amount of transaction.

Max Amount — Maximum dollar amount of transaction.

Serial Enter the item serial number for a specific issued item.

Number Serial Number Range — Click the hyperlink above Serial Number to enter a serial number
range or a maximum or minimum serial number.

Min Serial # - Minimum serial number.

Max Serial # - Maximum serial number.

Once search criteria are selected, click Apply to narrow your results.

e Results are displayed on pages of 25 items. Rows 1 - 25 of 29
o |f the Review Payee screen contains more than 25 items, the results
display on multiple pages. P - >
e Use the navigation buttons at the top of the review screen to review all
results.
Click Return to change the transaction status to Return.
Transaction Information Image Change Status
Transaction ID: 7740710
Account Number: oo 115 e Test Capture Only
Yos € |..\-_|: 12848 Non-Negntiable
Check Number: 729 DATE CHECK NO AMOUNT
04707 /2023 TN $i\‘- 5
Amount: $65.55
Issuance Payee: Mike Mechanics T Mike Mechanic

Sixty five and 35 cents

** Void ** Void ** Void **
1SN: 102202195 S DelLacre

12040000450 BAAbAbAAAS*729) #ODDOOOBSSS
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The Select a check return reason window displays. Select the appropriate return reason and click Save.

Select a check return reason:

® Amount Incorrect
Duplicate Presentment
O Fraudulent
Prior Stopped
Prior Void
) Refer to Maker
) Serial # Incorrect
) Signature Irregular
) Signature Missing

Stale Dated

Save

Once the return reason is saved, you are returned to the Review Payee screen, and the Return button
displays as an Undo button.
e |f you determine that the return should be undone, click Undo to change the status back to Pay.
e The screen reverts the button to Return.

Transaction 1D:
Account Number:
Check Number:
Amount:

Issuance Payee:

Transaction ID:
Account Number:
Check Number:
Amount:

Issuance Payee:

Transaction Information

7740710
0xx1115

29

$65.55

Mike Mechanics

7740709
01115
7290
$90.00

ups

Image

Non-Negatishle

Mike Mechanic

Sixty five and 55 cents

ISN: 102202195

200000450

Test Capture Only

CHECK NO. AMOUNT
7201 558

** Void ** Void ** Void **

S DeLacre

AALbERRMAS®T291 #D00000BSSS

Test Capture Only

Non-Negotiable
S 7 | S T -3 =T —
04/ 07/ 2023 7300 | 3 sn0

Pay UpPs

TaThe

gw Nincty and No cents

ISN: 102202194

200000450

** Void ** Void ** Void **

S beloere

AAbbEEEEAS*T290 40000005000

Change Status

Click Back at the top of the screen to return to the Transaction History screen.

< Back

Y Filters

Transaction ID:
Account Number:

Check Number:

Amount:

Transaction Information

Payee Review

7740710
wo1115
729

$65.55

Non-Negotiable

DATE

04707 /2003

Test Capture Only

CHECK NG AMOUNT

7291 S 6555

Change Status
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You are returned to the Transaction History view and may see the following alert message:

In order to view your changes, please refresh your
browser and review your filters.

Refresh the browser window to view the changes to the Transaction History screen. You will see the
previously changed item with the status of Return-User.

» 7740710 XXX1115 7291 $65.55  Return-User 04/07/2023
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